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1 SafetyNet Software Introduction 
 
The SafetyNet system is designed with flexibility in mind.  It is backwardly compatible with 
prior Amerex Fire & Gas Detection systems, but also offers the user the ability to customize 
an application using the available SafetyNet Configuration Utility software.  SafetyNet can also 
be used as a Data Acquisition system and an Event Recorder.  The purpose of this 
Programming Manual is to explain in greater detail, the building blocks that make up the 
Amerex SafetyNet System.   

 
SafetyNet is designed to be backwardly compatible to previous Amerex Vehicle Fire 
Suppression systems through the use of a number of common mechanical characteristics, 
(cables, sensors, panel size, etc.) but also through its Self Configuration capability.   
 
SafetyNet Modules are internally programmed to “recognize” the electrical characteristics of a 
wide variety of Amerex Vehicle System sensors.  Each sensor is identified by SafetyNet as to 
type of sensor, (Fire, Gas, etc.).  SafetyNet then operates using default settings, based upon 
the type of sensor.  For example, a Normally Open Spot Heat Sensor is automatically 
recognized as a Fire Sensor.  When that sensor detects a Fire condition, SafetyNet will 
actuate the Fire Suppression System.  The SafetyNet Operator Display will indicate a Fire 
condition and identify the module and sensor which detected the Fire condition.  SafetyNet will 
also indicate a Trouble condition if the sensor is operating outside of its design parameters.  
For example, if a wire to a Normally Open Spot Heat Sensor breaks, SafetyNet will indicate a 
Trouble condition.  The SafetyNet Operator Display will identify the module and sensor which 
has the problem.  

   
SafetyNet PC software takes the basic system operation a step further.   After installing 
SafetyNet software onto your PC setting up the Computer Interface Module, the user has the 
ability to connect to a SafetyNet System and perform the following: 
 

a. Modify System Configurations 
b. Download System Events 
c. Use SafetyNet as a Data Acquisition System 

 
Modify System Configurations – Using the SafetyNet PC software, the system user can 
modify SafetyNet configurations by naming sensors, adjusting relay functions, etc.  SafetyNet 
PC software also allows the designer to pre-configure SafetyNet and upload system design 
parameters to an existing design.   
 
Download System Events – The Operator Display has the ability to store up to 4095 separate 
“events”.  An event is defined as any message which appears on the Operator Display screen.  
An event is also recorded when a pushbutton is pressed, (i.e. Silence, Relay Reset, Push to 
Test).  The type of event is recorded along with a time and date stamp.  For example, a 
sensor Trouble Condition may be displayed as “Mod 1, Sensor 1, Trouble”.  This can later be 
viewed and downloaded using SafetyNet PC software P/N 16609 which allows access to the 
SafetyNet programming and event log via personal computer.  Reviewing system Events is 
useful in reconstructing previous situations, performing system maintenance and 
troubleshooting. This saved event log file can also be shared via email. 
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Using SafetyNet as a Data Acquisition Tool – Real time data is continuously analyzed by 
the SafetyNet system.  The SafetyNet PC software allows the user to tap into this flow of data.  
The Monitor Mode portion of SafetyNet provides an on screen view of real time sensor data.  
This is useful when testing a SafetyNet system and can also be used as an engineering 
analysis tool to assist in the location of combustible gas sensors, spot heat sensors, etc.  An 
additional feature allows the user to capture the sensor data, save the data to a file and then 
manipulate the data using software such as Microsoft Excel.  This saved data file can also be 
shared via email and printed out. 
 
 
SafetyNet Menu Introduction 
 
Once the SafetyNet software is installed on your computer, you can Run the program by 
selecting the SafetyNet Utility icon located on your desktop. 
 
 

 
Figure 1 - SafetyNet Utility Program icon 

 

 
Figure 2 - SafetyNet Start Screen 

 
 

If you are familiar with Windows pull-down menus, you will recognize the flexibility of the 
SafetyNet Configuration Utility.  The utility screen is made up of the following categories: 
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 File Menu 
 

 
Figure 3 - SafetyNet File Menu 

 
The File Menu allows the user to Create, Save and Open SafetyNet Configuration files.  You 
can also change PC to SafetyNet communication ports and change system access password. 
 
 
File Menu Options 
 

  New File - Allows the user to open a new file and build a new, untitled SafetyNet 
system configuration.  You must add one or more module configuration tabs using the 
"Add Module" dialog to create a valid SafetyNet configuration which can then be uploaded 
to a SafetyNet system.  If you have made changes to a previously opened configuration, 
you will be prompted to save them before the new configuration is created.  A library of 
various configurations can be maintained.  By default these configurations are stored in 
the “C:Program Files\SafetyNet\Config” sub-folder. 

 
 

  Open Existing File – Allows the user to open an existing system configuration file 
from disk.  A standard Windows file-open dialog is displayed, allowing you to choose an 
existing configuration file to open and edit.  SafetyNet configuration files are stored in a 
folder named "Config" and have a filename extension of ".cfg"  
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Figure 4 - Opening an Existing Configuration File 

 
 Save – Allows the user to save the current system configuration to a file on disk and 

optionally upload the configuration to a connected SafetyNet system.  If the configuration 
has not been saved to disk previously, you will be prompted to name the configuration file.  
The configuration filename can be any name that is valid for the Windows file system 
("long" filenames are supported); by convention, SafetyNet configuration files should be 
stored in the "Config" folder  

 
 Save As – This menu item is the same as the "Save" menu item, except that you will 

be prompted for a new configuration filename.  This feature can be used to support 
"template" configurations: a standard or "template" configuration can be opened, modified, 
and then saved to a new configuration filename.  

 

 
Figure 5 - Saving an Existing File 

 

  Preferences – Allows the user specify the serial communications port (COM ports 1-
32) on their PC to use with the SafetyNet Interface Module (p/n 16609).  Normally, the 
serial communications port is automatically set when the SafetyNet Communications 
Interface Module is first connected to your computer. 

 

 
Figure 6 - COM Port Selection 
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  Change Password – Allows the user to change the password required for access to 
advanced SafetyNet features.  You will be prompted to enter the current password before 
being allowed to choose a new password. 
 

 
Figure 7 - Password Input Window 

 
 

 Exit – Choose this menu item to exit the SafetyNet Configuration Utility.  If you have 
made changes to the current SafetyNet configuration, you will be prompted to save them 
before exiting. 
 
Recent Files - This submenu allows you to open the most recently used SafetyNet 
configuration files from a list, or to clear the list of recently used configuration files. 

 
Configuration Menu 

 

 
Figure 8 - SafetyNet Configuration Menu 

 
The Configuration Menu allows you to: 

- Create a SafetyNet System from scratch, 
- Edit existing configurations, 
- Copy and Rename existing configurations, 
- Upload-Download configurations to the SafetyNet System.  
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A “Configuration” is a specific arrangement of sensors, modules and software variables that 
make up a SafetyNet System.  While each individual application may be different, standard 
SafetyNet components may be arranged in such a way to create a custom configuration.  

 
 

Configuration Menu Options 
 

 

 Add Module – Allows the user to manually add a SafetyNet Module to a configuration.  
Once a Module is added to the current configuration, the user can then change the each 
individual module’s characteristics. 
 

 
Figure 9 - Add Module Menu 

 Remove Module – Allows the user to delete a module from a SafetyNet system 
configuration.   

 

 Copy Module Data/Paste Module Data - These menu items allow you to quickly 
copy data from one module configuration tab to another tab.  Use the 'Copy module data' 
menu item to copy the configuration data from the selected module configuration tab; then 
select another module tab and use the 'Paste module data' menu item to transfer the data.  
Note that both the source and target module tabs must be the same module type 
 

  Erase – Allows the user to erase an existing SafetyNet configuration.  Selecting this 
option connects the user PC to the SafetyNet system and erases the existing configuration.  
After you erase an existing configuration, the SafetyNet system will reconfigure itself to 
determine existing modules, sensors, and outputs.  SafetyNet software settings (delays, 
sensor & module names, etc.) are also returned to default values. You must enter the system 
password to proceed, and you will be prompted to confirm that you want to erase the 
configuration. 
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 Upload – Allows the user to “Write” a configuration to the SafetyNet system.  Selecting 
this option connects the user PC to the SafetyNet system and replaces the existing 
configuration with the current PC configuration.  You must enter the system password to 
proceed, and you will be prompted to confirm that you want to upload the configuration.  After 
replacing the existing configuration, SafetyNet will verify that the uploaded configuration 
matches the actual configuration.  The SafetyNet system will resume operations with the new 
configuration settings in effect. 
 

 Download – Allows the user to “Read” an existing configuration as currently loaded on 
an attached SafetyNet system.  Once the configuration is downloaded, it becomes the current 
configuration in your SafetyNet PC software utility. If you have made changes to a previously 
loaded configuration, you will be prompted to save the changes to disk before downloading.  
After a successful download, you can view and modify configuration settings and re-upload to 
a SafetyNet System or save the configuration to disk.  
 
 
Tools Menu 
 

 
Figure 10 - SafetyNet Tools Menu 

 
The Tools Menu allows the user to perform Maintenance and gather information from the  
SafetyNet System.   

 
Tool Menu Options 

 

 View Event Log  - Each Event, which occurs in the SafetyNet system, is recorded to  
memory residing in the Operator Display.  An event is defined as any condition (except for 
Fire System Maintenance Due) causing a message on the Operator Display screen.  Events 
are also recorded for Push to Test, System Reconfigurations, and other user modifications.  
The Operator Display event recorder can store 4095 events.  When the Operator Display 
memory is full, the first event recorded is over written by the most recent event.  By choosing 
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this menu item the user can retrieve events from an attached SafetyNet system.  The event 
log feature can be used to track the operation of a SafetyNet system over time.  The event log 
can be saved to disk as text file that can be imported into a word processing or spreadsheet 
program or exchanged via e-mail. 
 

 Maintenance Schedule – Choose this menu item to configure, reset, or disable the 
SafetyNet maintenance reminder feature.  The SafetyNet system can be configured to display 
a "Maintenance Due" message on the SafetyNet Operator Display Module.  You must enter 
the program password to use this feature.   SafetyNet indicates Maintenance Due by pulsing 
the audible alarm once and briefly displaying “Fire System Maintenance Due” on the operator 
display.  The “Fire System Maintenance Due” reminder will reappear every 10 minutes.  Once 
maintenance has been performed, the user must “Reset” the maintenance warning to a future 
date.  Disabling the Maintenance Warning stops the built-in reminder. 
 
 

 Set Clock – The Operator Display contains an internal clock that is set at the factory 
for US Eastern Standard Time.  The clock function is used during event recording and data 
logging operations.  You can reset the internal system clock using this menu.  SafetyNet 
software uses the current time and date from your PC.   
 

  Set Display Brightness – The brightness of the p/n 16389 Operator Display can be 
adjusted from 1 (dimmer) to 8 (brighter).  Default level is 4.  Display brightness adjustment 
affects only the VFD screen display and does not affect the LED brightness. You must enter 
the program password to use this feature. 
  

  Firmware Revision – Choose this menu item to retrieve firmware revision information 
from all modules of an attached SafetyNet system.  Each module contains software which 
includes a revision level - this utility allows you to check the revision levels of all modules in a 
SafetyNet system. 
 

 Monitor – Using the Monitor Mode allows you to view module, sensor and component 
data real-time.  This function also allows you to record data by “Logging” to an ASCII text 
format (*.txt).  If the data is to be Logged, it is by default saved to your PC in the “C:Program 
Files\SafetyNet\DataLog” folder. The data can then be exported to a spreadsheet or other 
program for manipulation, viewing and charting. 
 

 
 
 
 
 
 
 
 

Help Menu 
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Figure 11 - SafetyNet Help Menu 

 
The Help Menu provides information about SafetyNet and can provide assistance in the use of 
SafetyNet. 
 

 Contents – Choose this menu item to display a table of contents for the online help 
system.  There is quite a bit of easily accessible information in the Help Menu.  The Contents 
section allows the user to quickly locate specific information. 
 
 

 
Figure 12 - SafetyNet Help Menu Contents 
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 Index – Lists of key terms and subjects relating to SafetyNet.  Hyperlinks take you to 
detailed descriptions. 

 
 

 
Figure 13 - SafetyNet Help Menu Index 

 
 
 
 

 About – This displays the software revisions level and copyright information for the 
SafetyNet PC Configuration Utility. 
 

 
Figure 14 - Information regarding the SafetyNet Software Configuration Utility 
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2 SafetyNet Software Installation 
 
To use the SafetyNet system to its full extent, you will want to configure and use SafetyNet with 
a Personal Computer.  Before you can communicate with the SafetyNet system, there are a few 
but important preliminary steps to take.   A moderate level of computer experience is helpful 
when installing SafetyNet Software and the Interface Module (Amerex P/N 16609).. 

 
SafetyNet PC Software Installation Checklist 

 Obtain the Amerex P/N 16609 SafetyNet Interface Module and Software 
 READ  THESE INSTRUCTIONS! 
 Determine whether you have Microsoft Windows XP or 2000 
 Contact your network administrator for installation permission if necessary 
 Install SafetyNet software on your PC 
 Install SafetyNet Interface Module to PC’s USB Port 
 Install Interface Module USOTL4 Software Driver 
 Install Interface Module USB Serial Port Driver 
 Obtain Authorization Code from Amerex 
 Install Authorization Code on your PC 
 Connect PC to SafetyNet system 

 

IMPORTANT!!! 
Please read this application note before plugging the SafetyNet Interface USB-to-RS485 
Converter into your PC’s USB port for the first time.  This hardware device requires special 
driver software to be installed on your PC – while the installation process is not difficult, failure 
to follow the directions can result in software driver errors on some PC’s. 

2.1 Contents: 
1) Installing the SafetyNet Configuration Utility 
2) Installing the SafetyNet Interface USB-to-RS485 Converter 

a) Installation for Windows XP 
b) Installation for Windows 2000 

3) SafetyNet Activation Code 
4) Using Multiple SafetyNet Interface USB-to-RS485 Converters 
5) Miscellaneous notes 

 
Figure 1 – P/N 16609 SafetyNet Computer Interface Module 
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Figure 2 - SafetyNet Software CD 

  

2.2 Installing the SafetyNet Configuration Utility 
Before installing the software, ensure that you have adequate security privileges to install a 
program in the “Program Files” folder on your PC.  Consult your friendly network administrator if 
you are not sure. 
 

 
 

Step #1 
To install the SafetyNet Configuration Utility, place the installation CD-ROM in your PC’s CD-
ROM drive.  The installation should begin automatically – if your PC is not configured to run CD-
ROM’s automatically, you can use the “Add or Remove Programs” applet in the Windows 
Control Panel to start the installation.  When the installation program begins, the above screen 
appears – Select Next to continue. 
 
 



Part Number 16602 February 2007 Page 2-3 

 
Step #2 
The above screen appears, allowing you to choose the folder where the SafetyNet software will 
be installed.  To select the default installation folder (recommended), Select Next to continue. 
 
 

 
 
 
 
 

Step #3 
When this screen appears, verify that the destination folder is correct and then select Install.  
The SafetyNet software will be installed on your system. 
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Step #4 
When the SafetyNet software has been installed, the above screen appears.  Select Finish to 
complete the installation. 
 
 
 

IMPORTANT !!! 
Be sure to install the SafetyNet Interface USB-to-RS485 Converter before starting the 
SafetyNet Configuration Utility for the first time – this allows the SafetyNet utility to auto-detect 
the converter and configure it for communications with your SafetyNet system.  Once the 
converter is installed, you can start the SafetyNet Configuration Utility by double-clicking the 
“SafetyNet” icon on your PC’s desktop. 
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2.3 Installing the SafetyNet Interface USB-to-RS485 Converter 

2.3.1 Installation for Windows XP 
The following instructions assume that the SafetyNet Configuration Utility software has already 
been installed on your PC.  Installing the Configuration Utility from your CD copies the special 
driver software for the USB-to-485 Converter to a location on your PC’s hard drive so that it can 
be installed by Windows using the following procedure. 
 

 
Step #1 
Plug the USB-to-RS485 converter into an available USB port on your computer.  The screen 
above appears, telling you that a new device has been plugged into the USB.  Select the Install 
from a list or specific location (Advanced) option and select Next to continue. 
 

DO NOT SELECT INSTALL THE SOFTWARE 
AUTOMATICALLY!! 

 

NO! 

Yes! 
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Step #2 
The screen above appears.  Select “Search for the best driver in these locations”, de-select 
“Search removable media”, and select “Include this location in the search”.  Select the Browse 
button and navigate to the folder where the software drivers are located (this will typically be the 
folder “C:\Program Files\SafetyNet\Drivers”).  Once this folder is selected, select Next to 
continue. 
 
 

 
Step #3 
Windows will install the driver software and the above screen will appear (any warnings that 
appear during the installation can be safely ignored).  Select Finish to continue. 
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Step #4 
The above screen appears, prompting you to install a second driver.  Select the “Install from a 
list or specific location (Advanced)” option and select Next to continue. 
 

DO NOT SELECT INSTALL THE SOFTWARE 
AUTOMATICALLY 

 
 

 
Step #5 
The screen above appears.  Select “Search for the best driver in these locations”, de-select 
“Search removable media”, and select “Include this location in the search”.  Select the Browse 
button and navigate to the folder where the software drivers are located (this will typically be the 
folder “C:\Program Files\SafetyNet\Drivers”).  Once this folder is selected, select Next to 
continue. 
 

NO! 

Yes! 
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Step #6 
Windows will install the driver software and the above screen will appear (any warnings that 
appear during the installation can be safely ignored).  Select Finish to complete the driver 
installation. 
 
Your USB-to-RS485 converter is now ready to use with the SafetyNet Configuration Utility 
software – anytime you plug the converter into your PC, the converter software drivers will be 
loaded automatically. 
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2.3.2 Installation for Windows 2000 
The following instructions assume that the SafetyNet Configuration Utility software has already 
been installed on your PC.  Installing the Configuration Utility copies the special driver software 
for the USB-to-485 Converter to a location on your PC’s hard drive so that it can be installed by 
Windows using the following procedure. 
 

 
Step #1 
Plug the USB-to-RS485 converter into an available USB port on your computer.  The screen 
above appears, telling you that a new device has been plugged into the USB.  Select Next to 
continue. 
 
 

 
Step #2 
The screen above appears.  Select “Search for a suitable driver for my device (recommended)”, 
then select Next to continue. 
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Step #3 
The screen above appears.  Select “Specify a location”, de-select all other checkboxes and 
select Next to continue. 
 
 

 
Step #4 
When the above screen appears, select the Browse button and navigate to the folder where the 
software drivers are located (this will typically be the folder “C:\Program 
Files\SafetyNet\Drivers”).  Once this folder is selected, select OK to continue. 
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Step #5 
The screen above appears.  Select Next to install the software driver. 
 

 
Step #6 
Select Finish to complete the installation of this driver. 
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Step #7 
The above screen appears, prompting you to install a second driver.  Select Next to continue. 
 

 
Step #8 
The screen above appears.  Select “Search for a suitable driver for my device (recommended)”, 
then select Next to continue. 
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Step #9 
The screen above appears.  Select “Specify a location”, de-select all other checkboxes and 
select Next to continue. 
 

 
Step #10 
When the above screen appears, select the Browse button and navigate to the folder where the 
software drivers are located (this will typically be the folder “C:\Program 
Files\SafetyNet\Drivers”).  Once this folder is selected, select OK to continue. 
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Step #11 
The screen above appears.  Select Next to install the software driver. 
 

 
Step #12 
Windows will install the driver software and the above screen will appear.  Select Finish to 
complete the driver installation. 
 
Your USB-to-RS485 converter is now ready to use with the SafetyNet Configuration Utility 
software – anytime you plug the converter into your PC, the converter software drivers will be 
loaded automatically. 
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2.4 SafetyNet Activation Code 
 

 
 

When the SafetyNet Configuration Utility is started for the first time, you will be prompted to 
enter an “Activation Code” in the above screen.  An 8-digit ‘Machine ID Code” specific to your 
PC is generated; this code is used to generate a 16-digit “Activation Code” which unlocks the 
SafetyNet program.  An Activation Code may be obtained by contacting Total Fire Systems, Inc. 
by phone (919)-556-9161, fax (919) 556-9162 or email:sales-tfs@earthlink.net. 
 
 
 

IMPORTANT!!! 
Some auxiliary hardware devices, such as USB “Flash” (or “Thumb”) drives can alter the 
machine code/activation code for the SafetyNet Program, causing the program to prompt for a 
new activation code.  Unplug any auxiliary devices before starting the SafetyNet program to 
avoid this problem. 

2.5 Miscellaneous Notes 

o Using Multiple SafetyNet Interface USB-to-RS485 Converters 
- In some cases, it may be necessary to use one or more different SafetyNet 
Interface converters with a particular PC; for instance, when several SafetyNet 
Interfaces must be shared among a group of technicians. 
 
- Please note that each SafetyNet Interface has a unique serial number and must 
have a separate Windows driver installation specific to this serial number.  The 
reason for this is that Windows must assign a unique virtual serial port number (for 
example - COM5) to the converter. 
 
- When a new SafetyNet Interface converter is plugged into a USB port on your PC 
for the first time, Windows will prompt you to re-install the software drivers.  Use the 
procedure outlined in this application note to re-install the drivers. 
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- In practice, the simplest way to deal with this situation is to install the drivers for 
each SafetyNet Interface converter that will possibly be used with a particular PC 
before putting the PC in service on the shop floor.  The SafetyNet Configuration 
Utility will auto-detect the particular converter and prompt you to use it for 
communications. 

 
o It is a good idea to plug the converter into your PC before starting the SafetyNet 

Configuration Utility program.  This allows the program to “auto-detect” the SafetyNet 
Interface converter and prompt you to use the converter for communications with a 
SafetyNet system. 

 
o On some PC’s, there may be a delay (up to 30 seconds) between the time that the 

SafetyNet Interface converter is plugged into the PC and the time that the converter is 
recognized by the Windows operating system and can be used for SafetyNet 
communications. 

 
o The SafetyNet Interface converter enclosure has two circular 4-pin connectors provided 

for connecting to the SafetyNet system: one male connector and one female connector.  
Either connector can be used for communications with the SafetyNet system. 

 
o If your PC configuration changes, (i.e. new disk drives are installed) it may be necessary 

to obtain another Authorization Code from Amerex or Total Fire Systems. 
 

o The default location for the SafetyNet Program folder is “C:\Program Files\SafetyNet\.  If 
another location is desired, select “Change” and enter the new location path. 

 

 
Figure 3 - Microsoft Windows/Program Files Structure 

 
The SafetyNet Software installation program places a new icon on your Windows Desktop.  
SafetyNet may be started via the icon or by running SafetyNet.exe from the SafetyNet folder. 
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Figure 4 - SafetyNet Desktop Icon 

 
o P/N 16609 SafetyNet Interface Module includes both Male and Female connectors and 

is cleverly supplied with a 10’ p/n 14376 AMGaDS III Cable which can be installed to fit 
either Male or Female SafetyNet output ports.  Every SafetyNet installation will end up 
with two unused communication ports – either Male or Female - at the first and last 
modules in the system.  Depending upon how the installation was performed you may 
end up with either the Male or Female connector in the most accessible location.  The 
dual-sex interface module allows you the ability to connect to the most accessible 
connector port on a SafetyNet system.   
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3  Configuring a SafetyNet System 
 
Design of a SafetyNet system should only be determined after a Vehicle Hazard 
Analysis or Risk Assessment has been performed.  This type of analysis is beyond 
the scope of this manual and is covered in the appropriate manual for installation of 
the Amerex Fire Suppression or Gas Detection System (reference manuals 13400, 
13980, 16400 or 16601).  Design and Configuration of a SafetyNet system can 
proceed once the Hazard Analysis has been performed and the proper quantity and 
types of Agent Cylinders, Combustible Gas Sensors, Fire Sensors, etc have been 
determined.   Cable lengths between Module and Sensor and between Modules 
must also be carefully determined.  
 
A SafetyNet Configuration consists of a combination of the following: 
 

1) Types and numbers of system modules, 
2) Types and numbers of input sensors, 
3) Relay operation and delays, 
4) Actuation Delay and Mapping (identifying sensor operation to actuation 

sequence) 
5) Sensor and Communication cable positions, 
6) Identification of Modules and Sensors. 

 
Remember to Test your Configuration prior to Field Installation!! 

 
There are several ways to set up a SafetyNet system.  One particular method may 
be chosen over another for different reasons in different applications.  This portion of 
the manual will explain and give examples for: 
 

1) Hardware Self Configuration – Connecting the hardware and letting SafetyNet 
configure itself 

2) Hardware Self Configuration with Software Modifications - Connecting the 
hardware and letting SafetyNet configure itself then modifying the 
Configuration using Software 

3) Software Configuration for a Specific Hardware design – Designing the 
Configuration using Software then assembling the Hardware Configuration to 
match the Software Design 

 

3.1 Hardware Self Configuration 
 
1) System components have been selected, 
2) Component position and identification are not required, 
3) Default settings are acceptable. 
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Procedure:  
 
1) Make sure the system is not electrically powered, 
2) Physically connect the SafetyNet system components, 
3) If applicable, connect an Amerex p/n 14027 Alarm Test Module to the Actuator 

Output, 
4) Power up the system and allow it to Self Configure with no user input, 
5) SafetyNet allows the user to leave some sensor inputs as unpopulated, but will 

ask you to confirm that unpopulated inputs are not connected by design – Use 
the Arrow up or down keys (Alarm Silence & Relay Reset keys) to confirm that an 
input port is intentionally unpopulated. 

6) Press the Amerex Logo / Test-Confirm button to select your choice. 
 
Hardware Self Configuration Example – This system will be configured with one 
module, with (3) sensors.  Sensor position #1 will remain unused. 
 
Step #1 – Connect the modules and sensors together via interconnect cables, 
 

 
Figure 1 - Connect Cables to SafetyNet Modules 

 
Step #2 – Install the Amerex p/n 14027 if applicable, 
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Figure 2 - Attach Alarm Module if necessary 

 
 
 
 
 
 
 
 
 
Step #3 – Apply Power to the system 

 

 
Figure 3 - Power to Red Connector 

 
Figure 4 - Green Power LED indicates 

System Power to the Module
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-- The following Screen Shots show the SafetyNet Operator Display as it Self 

Configures -- 
 
 

 
 

Figure 5 - Only (1) module has been detected 
 

 
 

 
 

Figure 6 - The Operator Display has established Communication with the module 
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Figure 7 - The system has recognized that Sensor #1 is missing (by design in this example) 
 
 

 
 

Figure 8 - Press either the Relay Reset or Alarm Silence buttons to toggle the screen to 
"Yes".  Press the System Test – Confirm button to acknowledge that you recognize that 

sensor #1 is missing by design 
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Figure 9 - After pressing the System Test - Confirm button, the SafetyNet System 
"memorizes" the new configuration 

 

3.2 Hardware Self Configuration with Software Modifications  
 
1) System Layout is pre-designed, 
2) System configuration (module and sensor identification, relay timing, etc. must be 

modified using a PC) 
 
Procedure:  
 
1) Follow the same steps as above in the Hardware Self Configuration section, 
2) Connect the SafetyNet Interface module to your PC and the SafetyNet system, 
3) Download the Designed System configuration to your PC, 
4) Rename the modules, sensors, change relay timing, 
5) Save the Configuration, 
6) Upload the Configuration to the SafetyNet System, 
7) Test the system to verify correct operation. 
 
Hardware Self Configuration with Software Modifications Example - In this example 
we will design a system with two modules to include: 
 
- (4) gas sensors, 
- (1) SafeIR Optical Flame Detector, 
- (x number) Spot Heat Sensors, 
- (1) Manual Electric Pushbutton Release 
- Fire Relay, Gas Relay and Trouble Relay timer settings 
- All of the Sensors, Modules and Detection Zones will be named 
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Once the system hardware components have been connected and powered up and 
the system has Self Configured itself, the existing configuration can be downloaded 
to your PC for Configuration Modification. 
 
 

 
 

Figure 10 - Download the Configuration to your PC 
 

 
 

Figure 11 - The Configuration has been downloaded and is ready for editing 
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Figure 12 - Module 1 & Sensors have 
been renamed and the Relay timing has 

been adjusted 

 

 
 

Figure 13 - Module 2 & Sensors have 
been renamed and the Relay timing has 

been adjusted 
 

 
 
 
 

 
 

Figure 14 - The modified Configuration must be uploaded to the SafetyNet System 
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Figure 15 - A password is required for any Configuration changes. You will have to contact 
your system administrator if you do not have password access. 

 
 
 

 
 

Figure 16 - When uploading a new Configuration, your PC connects to the SafetyNet system 
 
 

 
 

Figure 17 - The SafetyNet system acknowledges the New Configuration 
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Figure 18 - SafetyNet verifies the Software Configuration matches the Hardware 
Configuration 

 

 
 

Figure 19- SafetyNet recognizes the two Modules in the Configuration 
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Figure 20  - SafetyNet verifies that the Software and Hardware match 
 

 

3.3 Software Configuration for a Specific Hardware Design 
 

1) System Layout is pre-designed with a specific system configuration (module and sensor 
identification, relay timing, etc. all are pre-determined) 
 
Procedure: 

1) Create a New configuration by selecting “File – New”, 
2) Select a module by selecting the ‘+’ sign, 
3) Choose the module to be added, 
4) Choose the sensor  types and zones, 
5) Choose the Class B Detection Zone if applicable, 
6) Choose the I/O port (J1 female or J2 male), 
7) Select the Relay transfer timing, 
8) Select the Discharge Delay if applicable, 
9) Name the Module and Sensors, 
10) Save the Configuration, 
11) Upload to SafetyNet Hardware 
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Create a New 
Configuration 
by selecting 
“File – New” 

Add a SafetyNet 
Module by selecting 
“+”, then choose the 
needed Module from 
the List 
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Choose the 
type of sensor 
and zone 

If needed, Relay 
Timing 
adjustments can 
be made here in 
0 – 15 second 
increments

Agent Cylinder 
Discharge Delay 
adjustments can 
be made here in 0 
– 15 second 
increments
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Modify the 
Class B 
Detection 
Zones as 
needed

Select the 
Network input 
and output by 
connector sex 
male or female

Name the 
Module and 
Sensors 
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Figure 21 - The modified Configuration must be uploaded to the SafetyNet System, 
 
 

 
 

Figure 22 - A password is required for any Configuration change. You will have to contact 
your system administrator if you do not have password access. 

Upload the 
New 
Configuration 
to the 
Hardware
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After uploading the new configuration to the system, the following screens are 
displayed, 

 
 

 
 

Figure 23 - When uploading a new Configuration, your PC connects to the SafetyNet 
system, 

 
 

 
 

Figure 24 - The SafetyNet system acknowledges the New Configuration, 
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Figure 25 - SafetyNet verifies the Software Configuration matches the Hardware 
Configuration, 

 

 
 

Figure 26- SafetyNet recognizes new Module in the Configuration, 
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Figure 27  - SafetyNet verifies that the Software and Hardware match, 
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4 Using the SafetyNet Event Log 
 
Event Log data consists of time and date stamped records of SafetyNet “Events”.  The event 
data is stored in memory in the Operator Display.   An event is defined as any situation (except 
for Fire and System Maintenance Due) causing a message on the Operator Display screen.    
Events are also recorded for Push to Test, System Reconfigurations, and other user system 
modifications.  Up to 4095 events can be stored in the Event Log File.  The Event Log may be 
accessed by connecting your PC to a SafetyNet system via the p/n 16601 Interface Module.  
Once connected, you have the ability to download all or only some of the events in storage.   
The more events you download, the longer the download takes.  Once you begin an Event 
Download, a progress bar advises you of the download status.  After the events are 
downloaded, you can store the data into a text file (*.txt) and can later import the event data into 
Microsoft Word, Excel or other type of software.  All saved downloads are by default stored in a 
Windows folder named EventLog (C:\Program Files\SafetyNet\EventLog). 

 

4.1 Capturing Event Data 
 
The Event Log is access by, 
 

 Connecting your PC to a SafetyNet system via the p/n 16601 Interface Module, 
 

 
 

 Open SafetyNet Software, 
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 Select Tools then View Event Log, 
 

 
 

 After selecting View Event Log, your screen will look like this, 
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 You can choose the number of Events to view.  The Event Log is viewed with the most 
recent Events first.  The default number is 20 which download in approximately 10 
seconds.  If the Event Log memory is full containing 4095 events, the download time 
may be as long as 4 minutes. 

 

 
 

 Select View and wait for the data to be downloaded, your screen will look something like 
this, 

 

 
 

 By selecting the header button above each of the column, you can sort the data by Date, 
Time, Module, etc. 
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 Once the Events are downloaded, you can save them to a file by selecting Save, 
 

 
 

SafetyNet will prompt you to save the Event log as Eventlog.txt which will be saved in the 
EventLog folder.  You can choose to save this file with another name or in another destination.  
Any word processing or spreadsheet software can import the *.txt file format.   A list of 
SafetyNet Event messages and their meaning are listed in the Appendix. 
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4.2 SafetyNet Event Log Messages 
The Table below lists the various events for which SafetyNet provides a screen display.  These 
events are also recorded in the Event Logging Feature provided by SafetyNet.  The display 
format is Event Type – Module I.D. – Sensor I.D. 
 
Display and Driver/Detection/Release Modules (firmware v1.640) 

Event 
Type 

Operator 
Display 

 
Event Cause 

 
Event Record 

LED 
Indication 

Audible 
Alarm 

 
 

Trouble 

 
 

TROUBLE 
Mod#  Com 

 
 

Communications 
Error 

No Response 
Invalid Response 
Invalid Module 
Missing Module 
Invalid command 
Software error 

 
Yellow 
Trouble 
Steady 

 
Single 
Pulse 

 
Trouble 

TROUBLE 
Mod#  Sensor# 

 
Sensor trouble 

Sensor missing 
Sensor wrong 
Sensor disabled 

Yellow 
Trouble 
Steady 

 
Pulsed 

 
Trouble 

 
TEMP Level 1 

 
Over-temperature 

level 1 

 
Variable Overheat Sensor Level 1 
Exceeded 

Yellow 
Trouble 
Steady 

 
Single 
Pulse 

 
Trouble 

 
TEMP Level 2 

 
Over-temperature 

level 2 

 
Variable Overheat Sensor Level 2 
Exceeded 

Yellow 
Trouble 
Steady 

 
Steady On 

 
Trouble 

TROUBLE 
Mod# Heat 1 or 2 

Class B Sensor 
Problem 

 
Heat 1 or 2 

Yellow 
Trouble 
Steady 

Single 
Pulse 

 
Trouble 

TROUBLE 
Mod# Battery 

Backup Battery 
Problem 

 
Battery Fault 

Yellow 
Trouble 
Steady 

Single 
Pulse 

 
Trouble 

TROUBLE 
Mod# Discharge 

 
Discharge 

Open Circuit at Actuator Yellow  
Trouble 
Steady 

 
Pulsed 

 
Trouble 

TROUBLE 
Mod#  Press Low 

 
Pressure low 

Open Circuit at Pressure Switch 
Input 

Yellow 
Trouble 
Steady 

 
Pulsed 

 
Trace Gas 

Trace Gas 
Mod#  Sensor# 

20% to 50% Gas 
Level 

Trace Gas Level Exceeded Yellow 
Trace 

Flashing 

 
Pulsed 

 
Significant  

Gas 

Significant Gas 
Mod#  Sensor# 

 
50%+ Gas Level 

Significant Gas Level Exceeded Red  
Significant 

Steady 

 
Steady On 

 
Fire 

FIRE 
Mod#  Sensor# 

 
Fire 

 
Fire 

Red 
Fire 

Steady 

 
Steady On 

None None System Clock set 
Configuration written 
Configuration erased 
Configuration reset 
Self-test 
Relays cleared 
Alarm silenced 
Reset (at power-on) 
User reset (logo button) 
Event log erased 
Configuration mismatch 
Power failure 
Maintenance schedule set 
Maintenance schedule reset 
Maintenance disabled  

None None 
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4.3 Event Definitions and Troubleshooting 
 

1. Communications Error  
This Event consists of module network errors.   A network error may include error in 
data transmission or interruption (break) in the data network.   Data transmission 
errors may arise from electrical interference from an external source (high power 
radio, GPS system, noisy alternator or other electronic device). 

 
 Trouble Shooting a Module Comm. Problem: 
 - Check all data cables and connections and verify proper system configuration, 
 - Ensure that data cables have not been damaged, 
 - Ensure cables are routed away from possible noisy devices. 
 

2. Sensor Trouble – Sensor Missing 
 This could indicate one of several problems: 

1) A system sensor in the SafetyNet configuration is missing, 
2) A system sensor is different than the SafetyNet configuration, 
3) A system sensor is damaged or disabled, 
4) A system sensor has become overheated, 
5) Sensor wiring is broken or disconnected. 
6) An electrically noisy component is interfering with sensor operation. 

 
 Trouble Shooting a Sensor Trouble Condition: 

- Disconnect the p/n 14036 Electric Actuator at the Agent Cylinder and install a 
p/n 14027 Alarm Module to disarm the fire suppression system, 

- Determine which sensor is causing the Trouble condition, 
- Check the wiring connections at both the panel and the sensor, 
- Determine whether the sensor cable has been damaged.  Cable damage may 

occur due to: 
o the cable being pinched by Ty-Wraps 
o cable routing through a vehicle bulkhead 
o due to normal vehicle maintenance 
o due to overheat conditions (routing near Turbo, exhaust, etc) 

- Wiggle the connections to determine whether the connection is intermittent, 
- Check to see if a noisy electrical component is in the area of the sensor, 
- Use the SafetyNet Monitor Mode to determine whether the sensor is performing 

properly, 
- After determining the cause of the Sensor Trouble, remove the p/n 14027 Alarm 

Module and reconnect the p/n 14036 Electric Actuator at the Agent Cylinder to 
re-arm the fire suppression system. 

 
 
 

3. Over-temperature level 1 
Variable Overheat Sensor warning level 1 is exceeded.   This message applies 
only to an analog heat sensor.  A programmed over-temperature alarm level is  
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set for each module.  If this alarm level is exceeded, the event will be recorded 
and will be indicated by a yellow Trouble LED and pulsed audible alarm. 

 
 Trouble Shooting an Over-temperature level 1: 

- Determine which sensor is causing the Trouble condition, 
- Use SafetyNet Monitor Mode to determine the current sensor reading, 
- Check area being monitored for signs of an overheat condition. 

 
 

4. Over-temperature level 2 
Variable Overheat Sensor warning level 2 is exceeded. This message only 
applies to an analog heat sensor.  A programmed alarm level is set for each 
module.  If this level is exceeded, the event will be recorded and will be indicated 
by a yellow Trouble LED and pulsed audible alarm. 

 
 Trouble Shooting an Over-temperature level 2: 

- Determine which sensor is causing the Trouble condition, 
- Use SafetyNet Monitor Mode to determine the current sensor reading, 
- Check area being monitored for signs of an overheat condition. 

 
5. Class B (Heat 1 or Heat 2) 

This trouble condition applies to the Class B detection circuits.  The p/n 16390 
SafetyNet Driver Panel includes (2) of these circuits generally consisting of one 
circuit of spot thermal heat sensors and another circuit including the Manual 
Release Switch.  Initially these circuits are identified as “Heat 1” and “Heat 2”. 

 
 Trouble Shooting a Class B circuit Fault: 

- Determine which Class B circuit is causing the error condition, 
- Disconnect the 14036 Electric Actuator at the Agent Cylinder and install a p/n 

14027 Alarm Module Obtain a p/n 14010 End of Line Device, 
- Check the resistance of the End of Line Device (should be approx 2.2k ohms) 
- Disconnect the Class B circuit with the trouble condition at the end of the 18” 

Detection Loop pigtail, 
 

 
 
 
 

- Attach a p/n 14010 End of Line Device at the end of the 18” Detection Loop 
pigtail,  

Disconnect 
cable at end 
of 18” Pigtail 
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- Check to see if the Trouble condition has cleared, 
- If Yes, then examine the length of Detection wiring and Heat Detectors 
- If No, then examine the Control Panel and Pigtail Cable. 
 
- Check for breaks or signs of abrasion in the wiring, 
- Check for signs of damage to spot heat sensors or wiring 
- Check for signs of overheating 

 
6. Battery Fault 

The p/n 16390 contains a backup battery which provides power to the system in 
the event of an electrical failure.  The backup battery is continuously supervised 
for proper operation.  In the event of a problem with the battery or the charging 
circuit a Battery Trouble condition may be displayed. 

 
 Trouble Shooting a Battery Fault: 

- Disconnect the p/n 14036 Electric Actuator at the Agent Cylinder and install a 
p/n 14027 Alarm Module, 

- Disconnect the cables on the front of the p/n 16390 SafetyNet Driver panel, 
- Remove the label from the back of the Driver panel, 
 

 
 
 

- Remove the (4) #6-32 screws from the back of the Driver panel, 
 

Attach p/n 
14010 EOL 
Device at 
Pigtail 
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- Inspect the battery, 
o Make sure the battery is intact 
 

 
 

o Check the (2) #4-40 screws holding the battery in place 
o Check the electrical connector to make sure it is intact 
o Replace the battery if necessary making sure to align the male and 

female connectors 
 

Check Battery 
Electrical 
Connection 

Check #4-40 Screws
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o Press the battery to reseat and replace the #4-40 screws.  Apply Loctite 
242 (Blue) as needed. 

 

 
 

 -  Replace the backplate.  Note that it is not symmetrical – there is a top and 
bottom.  Align the mounting holes with the panel spacers.  Replace the #6-32 
screws.  Apply Loctite 242 (Blue) as needed. 

 
- After determining the cause of the Battery Fault, remove the p/n 14027 Alarm 

Module and reconnect the p/n 14036 Electric Actuator at the Agent Cylinder. 
 
 

7. Discharge 
This could indicate a disconnected actuator cable, open wire in the actuator 
cable, open or activated actuator.  SafetyNet supervises the condition of the 
electric actuator p/n 14036.  If there is a break in the wiring from the SafetyNet 
system to the Actuator, a Discharge message is displayed.  

 
 Trouble Shooting a System Discharge Message: 

- Check the wiring at the panel and at the first electrical connection to ensure the 
connectors are tightly fastened 

 

Align Male & Female 
connectors 
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- Check the electrical connection at the p/n 14036 electric actuator  
 

 
 

- Check to ensure the p/n 14036 Actuator has not been fired, 
 

Electric Actuator 
p/n 14036 Not 

Connected 

Electric Actuator p/n 
14036 connection at 

SafetyNet panel 
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- Check wiring to ensure there no breaks or wiring damage 
 

Normal, Unfired 
p/n 14036 

Electric Actuator 

Fired p/n 14036 
Electric Actuator – 
Cannot be reset or 

reused 
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8. Pressure Low 
This indicates that there is an open circuit between the SafetyNet panel and the 
agent cylinder pressure switch.  The Agent Cylinder Pressure Switch is “closed” 
when the pressure in the Agent Cylinder is above a minimum pressure.  Possible 
reasons for this break could be a disconnected pressure switch cable, open wire 
in the pressure switch circuit, or low pressure in the agent cylinder. 

 
 Trouble Shooting a Pressure Low Message: 

- Check the pressure status of the Agent Cylinder by looking at the gauge, 
 

 
 

- Check the condition of the Agent Cylinder pressure switch 
- Check the Pressure Switch cable connection at the SafetyNet Panel, ensure that 

the connection is tight and not damaged, 
 

 
 

- Check wiring to ensure there are no breaks or wiring damage. 
 
 

Agent Cylinder 
Pressure Switch 

Connection 

Agent Cylinder 
with Zero 

Pressure in 
Cylinder 

Agent Cylinder 
Pressure Switch 
Connection on 

SafetyNet Panel 
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9. Trace Gas  

This message indicates that the Trace Gas Level is exceeded.  Combustible gas 
exists in the area of the sensor.  The default SafetyNet Trace Gas set point is 
20% of the LEL of Methane in a normal atmosphere which is equivalent to 1% 
Methane in Air.   

 
 Trouble Shooting a Trace Gas condition: 

A problem in tracking down a low level Methane gas leak is that the gas is not 
visible, often odorless and it disperses readily in atmosphere.  A method used to 
find small leaks is by using electronic combustible gas sensing equipment.  Trace 
Gas conditions may exist for only a short period of time.  By the time 
maintenance personnel are available to search for a leak using handheld gas 
sensing equipment, the gas causing the alarm may have dissipated.  Since 
Methane Gas is lighter than air, small gas leaks can accumulate in trapped 
pockets in vehicle compartments. 

 
Possible areas for Methane gas to accumulate are: 

o Fuel filler compartments 
o Roof Mounted Compartments and Shrouds 
o Engine Compartment 
o Passenger Compartment 

 
Typical causes for a Trace Gas condition are: 

o Loose fittings and tubing 
o Pressure Relief Devices 
o Flexing of fittings & tubing as vehicles travels 
o Thermal expansion and contraction due to outside air temperature 
o Thermal expansion and contraction due to fueling 
o Nearby vehicles with poorly tuned exhausts 
o Cold started engines 
o Other sources of combustible gas (spilled hydrocarbon fuels, paint spray 

booths, etc) 
 

If a Trace Gas condition is still present 
o Identify the sensor in Trace Alarm then use a handheld gas detector to 

determine the location of the actual gas leak, 
o If a gas leak is not found, check the cable connector at the sensor and 

SafetyNet panel, 
o Use the SafetyNet Event log to identify the time, date and location of the 

Trace Gas alarm, 
o Use the SafetyNet Monitor Mode to examine Gas Sensor voltages, 
o Refer to Section 5-Using the SafetyNet Monitor Mode to determine 

typical sensor operating voltages. 
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10.  Significant gas 
This message indicates that the Significant Gas Level is exceeded.  Combustible 
gas exists in the area of the sensor.  The default SafetyNet Significant Gas set 
point is 50% of the LEL of Methane in a normal atmosphere which is equivalent 
to 2 ½% Methane in Air. 
 

 
 Trouble Shooting a Significant Gas condition: 

Troubleshooting a Significant Gas condition is the same as that for a Trace Gas 
condition with the exception being that a Trace Gas condition falls between 20% 
and 50% of the LFL of Methane.  A Significant Gas condition may be from 50% 
to 100% of the LFL of Methane.  A Significant Gas condition may indicate that a 
Combustible level of Methane Gas is present. Greater care must be taken if a 
Significant Gas condition exists.  Refer to your local Safety Official for guidance 
in determining the cause of a Significant Gas leak. 

 
 

11. FIRE 
A sensor has recorded a Fire event.  A Fire condition occurs only when a 
SafetyNet Fire sensor senses a Fire Alarm condition.  Spot thermal, Linear Heat 
Sensors, Manual Push Buttons, Optical Flame Sensors and Analog Heat 
Sensors are all capable of sensing a Fire condition.  Upon sensing a Fire 
condition, the SafetyNet system begins an actuation sequence.  The SafetyNet 
Event Log will record the following sequence: 
 

1) Fire  - Module and Sensor identified with a Time and Date stamp, 
2) Actuator Activated – Date and time of actuation signal, 
3) Actuator fault – Date and time of system actuation 

 
Typical Events which would follow a Fire event would include: 

1) System - Alarm Silence – Identifies the Date and time that the vehicle 
operator silenced the audible alarm, 

2) System – Relays Cleared – Identifies the date and time that the vehicle 
operator reset the shutdown relay. 

3) Sensor Trouble – During recovery from a high heat condition, the sensor 
sensing the fire may present unstable signals which SafetyNet may 
determine are outside the normal operating parameters for this sensor.  
The sensor may remain in a Trouble condition until it is replaced or 
otherwise returns to a normal condition. 

 
12. System 

A number of conditions can be recorded as System Events.  Any user interaction 
(Alarm Silence, Push to Test, etc.) with the Operator Display or Configuration 
adjustments is recorded as a System Event.   System events are recorded in the 
Event Log and do not require troubleshooting. 
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5  Using the SafetyNet Monitor Mode 
 
During normal operation, SafetyNet is constantly checking all module and sensor data.  The 
SafetyNet Monitor Mode option allows you to view this sensor and module data in real time.  
Monitor Mode also gives you the option of saving this data to a text file that can be viewed at a 
later time.  You can select the Log Interval that determines how often SafetyNet gathers data 
and records it to a file.  The smaller the interval, the more data generated.  The longer the 
interval, the less data generated.  This function is useful in system inspection, troubleshooting 
and general information gathering. 
 
A moderate level of computer knowledge makes this experience a little easier.  Using the 
collected data, transferring it to a spreadsheet and graphing or charting the data takes a bit 
more experience with multiple software packages. 

5.1 Operating the Monitor Mode 
 

 Open SafetyNet Configuration Software, 
 

 
 Select Tools, 
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 Select Monitor, 

 

 
 

 Choose whether to Save and Record the Data to a DataLog file or to simply Monitor 
data, 

 
 If Log Data is selected, then determine Log File name and determine the Log Interval.  

The default settings are C:\Program Files\SafetyNet\Datalog\DataLog1.txt with a Log 
interval of 5 seconds, 

 

 
 

 Select Monitor to begin the Monitor Mode, 
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 One window will appear on the screen for each of the modules in the SafetyNet system.  
Drag each window to the side for easier viewing. 

  

 
 

 To end the Monitor Mode, close each open Monitor window.  This returns you to the 
main menu 
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5.2 Monitor Menu Definitions 
 

- Module Type – Shows module type, part number and software revision in the monitor 
mode window, 

- Sensor A & B – Sensor and Reference voltages for connected sensor (see chart for 
typical values) 

- Pressure Switch – Indicates pressure switch connection status 
- Sensor Current – Indicates total sensor current usage 
- Power Input – Voltage input from vehicle battery/charging system 
- RS-485 power input – SafetyNet regulated network voltage 
- Battery Input – Indicates Driver internal battery voltage status 
- Board Temperature – Indicates module temperature via an on-board temperature 

sensor (if sensor is not present –default temperature is 32 degrees) 
- Discharge – Indicates the status of the actuation device.  Red indicates Activated 
- Relays – Indicates the status of the module relays.  Each module contains from one to 

three relays.  Individual relays are provided for Trouble, Significant Gas 
and Fire for the p/n 16390 Driver panel.  All other modules include only 
one relay which serves as a local relay for Trouble, Gas and Fire.  See 
application notes for additional relay mapping information 

5.3 Monitor Mode Typical Sensor Voltages 
 

o This chart is to be used for troubleshooting reference purposes only. 
o All voltages are typical at approx 70 deg F. 

 
 

Voltage Reference Typical ‘A’ Voltage Typical ‘B’ Voltage 
SafeIR Optical Sensor 2.30 - 2.50 vdc 2.30  – 2.50 vdc 
Combustible Gas Sensor 0.60 – 1.50 vdc 3.4 – 3.9 vdc 
Spot Thermostat 4.00 vdc 0.00 vdc 
Manual Release Switch 4.00 vdc 0.00 vdc 
Speed Sensor 4.95 vdc 4.95 vdc 
Variable RTD (Analog Heat 
Sensor) 

Not applicable – Temperature 
is Displayed 

Not applicable 

Setpoint RTD (Fixed 
Reference Analog Heat 
Sensor) 

Not applicable Not applicable 

Pressure Switch 0.0 vdc Not applicable 
Sensor Current Variable depending upon 

sensor types 
 

Power Input Minimum – 10 vdc Maximum – 50 vdc 
RS-485 power input Minimum – 10 vdc Maximum – 50 vdc 
Battery Input Normal low – 8.4 vdc Normal high – 10.5 vdc 
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5.4 Using Monitor Mode with Spreadsheet Software 
In order to use, manipulate and display the data you’ve recorded, you must first have an 
understanding of how the various Amerex sensors operate and exactly what you are planning to 
analyze or present.  
 
Amerex sensors operate in two basic patterns: 1) Analog (Combustible Gas, Variable RTD, 
SafeIR Optical Flame) and 2) Digital (Manual Pushbutton, Spot Thermal, Speed, Linear Wire).  
Analog sensors continuously provide a varying voltage signal that is collected by SafetyNet.  
This varying voltage can be used to make some determination as to how the sensor is reacting 
in its environment.  Digital sensors are either on or off and do not give an indication prior to 
reacting to their designed environment. 
 
Analog Sensor Example 
The following chart was obtained after importing SafetyNet data into an Excel Spreadsheet.  
The data was edited and used to create this chart.  The Amerex p/n 14198 Methane Gas 
Sensor provides a continuous stream of voltage which varies depending upon the amount of 
combustible gas present.  The upper lines indicate the various sensor alarm levels, the lower 
lines indicate the actual gas levels measured by each individual sensor.  After viewing the data 
provided, it was determined that a pressure relief device was venting combustible gas on a 
periodic basis which was then picked up by Amerex gas sensor #3.   
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Analog Sensor Example 
 
The following chart shows the digital off-on-off signal obtained from an Amerex Manual Release 
Switch p/n 14053.  A “Normal” condition for this switch is approximately 4.0 vdc.  Upon Switch 
closure, the voltage rises to approximately 5.0 vdc.   
 

V oltage S ignal fo r Am erex Manual S w itch

0

1

2

3

4

5

6

15 :49 :1 2

15 :49 :2 9

15 :49 :4 8
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15 :50 :2 6

15 :50 :4 5

15 :51 :0 2

15 :51 :2 0

15 :51 :4 0

15 :51 :5 8

15 :52 :1 7

15 :52 :3 6

15 :52 :5 4

15 :53 :1 4

15 :53 :3 4

15 :53 :5 2

15 :54 :1 1

15 :54 :3 0

15 :54 :4 8

15 :55 :0 6

15 :55 :2 4

Tim e

V
ol

ta
ge S eries 2

 
 
 

Keep in mind that SafetyNet captures all the available data, not just the data you’re looking for.  
Some editing and manipulation is required.  A reasonable skill using the applicable computer 
software is necessary.   
 
The basic steps involved in capturing Real Time data, saving the data, and importing and 
manipulating the data in Microsoft Excel are as follows: 
 

 Create a Monitor Mode session using SafetyNet, 
 Setup your Data Capture interval and save the data to a file, 
 Import the *.txt data into Microsoft Excel, 
 Sort the data if necessary, 
 If the data is to be charted, then 
 Select the Data to be charted 
 Create a chart in Excel 
 Customize the chart (title, axis titles, etc) 
 Export the chart to Word Processing if necessary. 
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5.5 Understanding the Downloaded Data 
 
The SafetyNet Configuration Utility can save module/sensor data downloaded from an attached 
SafetyNet system to disk.  Data monitor files are created in tab-delimited ASCII format, which is 
compatible with Microsoft's Excel spreadsheet application. 
 
Each data sample is represented by one row of data divided into 24 columns/fields, as follows: 
 
Date - Date the data sample was recorded to disk. 
 
Time - Time of day the data sample was recorded to disk. 
 
Module - Module reporting this individual data sample. 
 
Type - The type of module, "Driver", "Detection", etc reporting data. 
 
Sensor 1 – 4 - The type of sensor attached to this connector, "Optical", "Gas", etc. 
 
Sensor 1A/Sensor 1B - Two separate voltages measured in volts DC, reported by Sensor 1. 
 
Sensor 2A/Sensor 2B - Two separate voltages measured in volts DC, reported by Sensor 2. 
 
Sensor 3A/Sensor 3B - Two separate voltages measured in volts DC, reported by Sensor 3. 
 
Sensor 4A/Sensor 4B - Two separate voltages measured in volts DC, reported by Sensor 4. 
 
Relays/sensors - Hexadecimal bitmap representation of the relay enable and sensor enable 
states, as follows: 
 
Bit 0 Not used 
 
Bit 1 Fire relay (0 = de-energized, 1 = energized) 
 
Bit 2 Gas relay (0 = de-energized, 1 = energized) 
 
Bit 3 Trouble relay (0 = de-energized, 1 = energized) 
 
Bit 4 Sensor 1 (0 = disabled, 1 = enabled) 
 
Bit 5 Sensor 2 (0 = disabled, 1 = enabled) 
 
Bit 6 Sensor 3 (0 = disabled, 1 = enabled) 
 
Bit 7 Sensor 4 (0 = disabled, 1 = enabled) 
 
For example "F0" would indicate "all sensors enabled, all relays off". 
 
Discharge - Voltage, measured in volts DC, present at the discharge actuator output, if the 
module has actuator discharge capability. 
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Pressure switch - Voltage, measured in volts DC, present at the pressure switch input, if the 
module has actuator discharge capability. 
 
Sensor Current - The amount of current, in milliamperes (mA), consumed by all sensors 
connected to this module. 
 
Module power input - The voltage, measured in volts DC, supplied to the module by the 
vehicle main battery.  Note that if the module is not connected to the vehicle battery, it receives 
power from the RS485 bus cabling; the module power voltage will be 0.0 volts in this case. 
 
RS485 power input - The voltage, measured in volts DC, supplied by the module's RS485 bus; 
for modules not attached directly to the vehicle battery, this is the module's power voltage. 
 
Battery input - The voltage measured in volts DC, supplied by the system backup battery 
(Driver Panel and Battery Backup modules only). 
 
Board temperature - The temperature, in degrees Fahrenheit, measured inside the module 
enclosure. 
 

5.6 Using the Monitor Mode Data with Microsoft Excel 
 
The following example describes the basic method used in importing and manipulating the data, 
 
Example – Chart gas sensor voltages over time using a Microsoft Excel spreadsheet for a 
SafetyNet system consisting of: 

- (2) Modules (p/n 16390 Driver Panel and p/n 16391 Detection Module) 
- (4) p/n 14198 Combustible Gas Sensors 
- (1) p/n 15799 SafeIR Optical Flame Detector 
- (1) p/n 14053 Manual Release Switch 
- (1) p/n 17360 Speed Sensor 
- (1) p/n 16603 Analog Heat Sensor 

 
This example assumes you’ve already captured and saved the data as described earlier. 
 
Step 1 – Start Microsoft Excel and open the file previously saved.  The default location is 
C:\Program Files\SafetyNet\DataLog\DataLog1.txt.  Excel by default looks only for *.xls files, be 
sure to allow Excel to look for “All File Types - *.*”. 
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Step 2 – Excel will automatically import *.txt format files.  Accept the default values of delimited 
starting at row 1. 
 

 
 

Step 3 – Excel imports the data as it was recorded by SafetyNet.  As mentioned earlier, 
SafetyNet records quite a bit of data.  Initially the data is sorted by time so in order to separate 
the gas sensors data from the rest of the data – you’ll have to do some editing. 
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Step 4 – To begin the clean up, Select all the data and use the Tools menu to Sort the data.  
One method would be to sort by Module.  This separates all of the sensor/module data by 
module. 
 

 
 
 

Step 5 – In this step, the data has been cleaned up by deleting a few unused columns and by 
moving all of the gas sensor data together. 
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Step 7 – In order to chart the data, it must first be selected.  This example shows the selection 
of both the A & B voltages for all four p/n 14198 Combustible Gas Sensors. 
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Step 8 – The data is now ready to be easily charted.  Select the charting option and choose the 
charting method of your choice.  This example shows a Trend Line Chart. 
 

 
 

Step 9 – The results of the data and charting selection is shown below. 
 
 

 
 

Step 10 – Selecting the data column for Time for the X-axis allows us to view the chart over a 
given time period.   
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Step 11 – Customize the chart by adding a title and descriptions for the x & y axis. 
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Step 12 – Further customization can be done by identifying sensors, adding comments, etc.  
This chart shows in graphical format what raw data cannot.  This Monitor Mode session shows 
perfectly behaving p/n 14198 Combustible Gas Sensors.  This is the typical pattern with the 
actual gas levels at approximately 1 vdc and the individual sensor alarm levels at approximately 
3.8 vdc.   
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6  SafetyNet Relay Operation & Sensor Mapping 
 
 

6.1 Relay Operation 
Each SafetyNet Module contains either a single or multiple relays.  All of the relays are 
single pole double throw (SPDT)/ Form C type devices.  Depending upon the type of  
SafetyNet module, the module relay may perform separate or multiple functions.  The 
system designer should consider how relay communication from module to vehicle 
electronics may best be performed.  
 

Module Type # of Relays Relay Functions 
p/n 16390 Driver Module 1 Fire 

“     “ 1 Gas 
“     “ 1 Trouble 

p/n 16391 Detection Module 1 Fire, Gas 
p/n 16392 Releasing Module 1 Fire, Gas 
p/n 16395 Detection-Release Module 1 Fire, Gas 
   
 
Relay Logic 
Each module relay operates specific to that module and is not common across the 
network of modules with the exception of the Trouble Relay.   An event on a single 
module which causes that module’s relay to transfer will not cause all of the other 
module relays to also transfer.  It is recommended that relay logic/shutdown is bench 
tested once a system configuration is developed. SafetyNet relay logic is best explained 
using a series of examples: 
 

- A system includes a Driver Module and a Detection Module.  The Detection 
module includes all Gas Sensors.  If a single Gas Sensor reaches a Significant 
gas level, the relay in the Detection Module will transfer but the Gas relay in the 
Driver panel will not transfer. 

 
- A system includes a Driver Module and a Detection Module.  The Detection 

module includes all Gas Sensors.  If a single Gas Sensor cable becomes 
damaged, the relay in the Detection Module will not transfer but the Trouble relay 
in the Driver panel will transfer. 

 
- A system includes a Detection Module only.  The Detection Module includes only 

Gas Sensors.  If a single Gas Sensor cable becomes damaged, there is No 
Trouble relay indication.  Trouble is only indicated on the Operator Display. 
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6.2 Sensor Mapping 
 
A SafetyNet system may consist of a number of different modules and sensors 
providing Detection and Agent cylinder releasing capability to different Hazard 
Areas or Zones.  The term Sensor Mapping is used to describe the logical 
operation between Fire Sensors and Fire System Activation.  Sensor Mapping 
allows the system designer to choose which sensors on a selected detection 
input module are to be used to trigger the actuator for a particular release zone.   
This release zone may be on one or multiple modules. 
 
An example would be individual detection and suppression zones consisting of a 
vehicle engine compartment, battery compartment and exhaust compartment.  
Each zone may be considered a separate hazard and may be provided with 
separate detection and suppression systems. 
 
The SafetyNet Configuration utility software must be used to determine which 
sensors are used to trigger the fire suppression system designated for a 
particular release zone.  Only those sensors designated as Fire sensors may be 
used to trigger a suppression system.  
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Detection & Suppression Example #1 
 
 
Assume a two module system (module A & module B) with two separate Fire 
Suppression systems (zones) on each module.   
 
 

 
 
 

 
 

 
 
 
 
 
 
 

Option 1 (Default Setting): A fire detected on module A activates A and B, but a fire 
detected on B only activates B but not A, 

 
 
 
 
 

 
 
 

 
 
 
 

 
 

 

Option 1 
(Default Setting) 

Module A 
(p/n 16390) 

Module B 
(p/n 16395) 
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Detection & Suppression Example #2 
 
 
Assume a two module system (module A & module B) with two separate Fire 
Suppression systems (zones) on each module.   
 
 

 
 
 

Option 2: A fire detected on ether module (A or B) activates both modules 
 
 
 
 
 
 
 

  

 
 
 
 
 
 
 

 
 

Module A 
(p/n 16390) 

Option 2 

Module B 
(p/n 16395) 
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Detection & Suppression Example #3 
 
Assume a two module system (module A & module B) with two separate Fire 
Suppression systems (zones) on each module.   

 

 
 
 

Option 3: A fire detected on ether module (A or B) activates only that module, but a 
Manual Release button located anywhere in the system releases all Fire Suppression 
systems. 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 

Module A 
(p/n 16390) 

Option 3 

Module B 
(p/n 16395) 
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Detection & Suppression Example #4
  
Assume a two module system (module A & module B) with Multiple Detection 
and Releasing Zones.   
 

 
SafetyNet has the capability of tying specific detection zones to specific releasing zones.   In 
this example we show a p/n 16391 Detection Module and a p/n 16392 Releasing 
Module.  Using the SafetyNet software utility the release zone number is displayed in 
the the window titlebar ("Zone 1-4").  The name of the selected (or "mapped") detection 
module is displayed above the sensor checkboxes 
(for example, "Mapped module: Mod 1).  To enable/disable a particular sensor for this 
release zone, click the checkbox next to the name of the sensor.  When a sensor is 
enabled, if it detects a fire condition, the actuator for this release zone will be triggered.   
 
By default, all available sensors are enabled.  Some sensors (for example, gas sensors) 
are not used to detect fire conditions; these sensors will appear disabled in the dialog 
and cannot be enabled. 
 
 

  
 

 
 
 

 
 

When you have enabled/disabled the desired sensors, press the "OK" button to save the 
selections.  Press the "Cancel" button to exit without making any changes to the 
configuration. 
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7 Miscellaneous  Menu Functions 
 
  

7.1 Change Password 
 
Configuration Utility Menu File 
Advanced Features? No 
Password Required? Yes 
 
 

 
Figure 1 - Select change password from File Menu 

 

 
Figure 2 - Enter original password 

 
 

 
Figure 3 - Enter NEW password & confirm 
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7.2 Erase Event Log (Advanced Features) 
 
Configuration Utility Menu Tools 
Advanced Features? Yes 
Password Required? Yes 
 
 

 
Figure 4 - Select Erase Event Log from Tools Menu 

 

 
Figure 5 - Enter password 

 

 
Figure 6 - Acknowledge Erase Event Log 
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7.3 Set Clock 
 
Configuration Utility Menu Tools 
Advanced Features? No 
Password Required? Yes 
 

 
Figure 7 - Select Set option in Tools Menu 

 
 

 
Figure 8 - Enter password 

 

 
Figure 9 - Enter time and date 
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7.4 Set Maintenance Schedule 
 
Configuration Utility Menu Tools 
Advanced Features? No 
Password Required? Yes 

 
 

 
Figure 10 - Select Maintenance Schedule from Tools menu 

 

 
Figure 11 - Set the maintenance schedule 

 
Figure 12 - Enter password to set the Maintenance Schedule 
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7.5 Set Display Brightness 
 
Configuration Utility Menu Tools 
Advanced Features? No 
Password Required? Yes 
 
 

 
Figure 13 - Select Set Display Brightness 

 

 
Figure 14 - Enter password to change brightness 

 

 
Figure 15 - Select brightness level 

 

 
Figure 16 - Select Set Level to change brightness 
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7.6 Upload Display Text (Advanced Features) 
 
Configuration Utility Menu Tools 
Advanced Features? Yes 
Password Required? Yes 
 
 

 
Figure 17 - Select Upload display text to modify Operator Display text 

 

 
Figure 18 - Enter password to change the display text 

 
 

 
Figure 19 - Select the Display Text file *.txt to upload.  This example lists English as the 

chosen text file 
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7.7 Check Firmware Revisions 
 
Configuration Utility Menu Tools 
Advanced Features? No 
Password Required? Yes 
 
 

 
Figure 20 - Select Firmware Revisions to view module firmware revision status 

 
Figure 21 - This lists the module firmware revision levels 

 
 
 


